What Is Merchandising?

Merchandising involves the coordination of buying merchandise that customers want in the proper quantities and then selling that merchandise at a price that customers are willing to pay. It is also worth noting that customers want merchandise where they want to buy it. Often this means that customers want to buy products where it is convenient. Nevertheless, customers will, on occasion, overlook convenience when the product is one they want badly enough. A successful retailer will stock an assortment of merchandise types that appeal to customers' various buying needs.

Types of Merchandise

When planning the merchandise assortment for a store it is important to be aware of and understand the types of merchandise. Merchandise of all sorts can be grouped into four categories, or types. The merchandise types are: staple, fashion, seasonal, and convenience.

**Staple Merchandise**

Staple merchandise is the basic stock of a store. It is stocked year round and comprises a good portion of store sales. These items are what customers need on an ongoing basis and tend to sell well year after year. Examples of staple merchandise include bread and eggs in a grocery store and socks and shoes in a department store.

Main Idea

In this unit we will explore merchandising and its importance to store sales and profit. We will discuss merchandise plans, types of merchandise, and stock lists. Then we will learn how merchandising affects sales. Lastly, we will review some merchandising math.

After completing this lesson you will be able to:

- Give examples of the four main categories of merchandise
- Explain the importance of stock lists and inventory control on merchandising
- Describe how sales are affected by the strategic placement of merchandise throughout a store - including the store entry, checkout lanes, and back of the store
- Analyze the financial impact of rearranging products
- Calculate projected sales based on past sales data and planned percentage increase

**Key Terms**

- Merchandising
- Staple Merchandise
- Fashion Merchandise
- Seasonal Merchandise
- Convenience Merchandise
- Stock Lists
- Basic Stock List
- Model Stock List
- Never-out Stock List
- Impulse Purchases
- Point of Purchase (POP) Displays
- Related Merchandise
Fashion Merchandise

Fashion merchandise consists of items that are stocked for several years and that have solid sales over that time period. An example is women’s capri pants. They have been selling well for several seasons and will probably continue to sell well for several more. Eventually women will tire of them and will switch to buying a different style.

Seasonal Merchandise

Seasonal merchandise consists of items that sell well during particular times of the year that are stocked only for that selling period. Once the selling period is over, unsold seasonal merchandise is marked down to encourage quick sales. Examples of seasonal merchandise include windshield wiper fluid in the fall and winter and sunscreen in the spring and summer.

Convenience Merchandise

Convenience merchandise consists of items customers buy without thinking very much about the purchase. This type of merchandise is purchased often or even on a daily basis. Examples of convenience merchandise include a cup of coffee or a can of soda.

Stock Lists

Stock lists are tools that retailers use to help them keep a close eye on the inventory they stock. These lists assist retailers with the task of maintaining correct quantities of the four types of merchandise discussed above. Stock lists are just what the name indicates: itemized and detailed listings of the merchandise a store or department should have for sale. Most retailers categorize their merchandise into three lists—a basic stock list, a model stock list, and a never-out stock list.

Basic Stock List

The basic stock list keeps track of the staple merchandise that the store should always keep in inventory. These items are the ones with regular customer demand. The basic stock list will usually note a minimum quantity that should always be in inventory for each item on the list. This list also notes the number of items to be reordered when needed. Daily study of this list will help ensure that basic items are always in stock and that no sales are lost.

Model Stock List

The model stock list is used to keep track of items of fashion merchandise. Items of fashion merchandise change more often than basic stock list items so the list is not as detailed. Monitoring of the model stock list can give valuable information about best-selling price points, styles, and colors.

Never-out Stock List

The never-out stock list can be used for all four types of merchandise. Typically the never-out stock list is used to keep track of the best-selling merchandise. This list should be monitored frequently to ensure that these popular items are always available in sufficient quantities. This list changes often as newly popular items are added and less popular ones are removed.
Merchandising and Sales

Merchandising can have a decisive effect on sales in a store or department. Most retailers plan sales for their stores based on the sales for the same period in the previous year. The general rule that is often followed in forecasting sales is to plan for a ten percent increase over last year’s sales for the same time period. Of course, retailers should consider current business circumstances when planning and should act accordingly.

To meet sales goals there must be merchandise for customers to buy. Moreover, there must be enough merchandise for customers to feel that they are able to make a choice from an adequate selection. Yet, there must not be so much merchandise that customers are overwhelmed or unwilling to sort through very large quantities in order to make their merchandise selections.

Merchandising for Profit

Retail selling space is a valuable commodity that retailers use to maximize store profits. The strategic placement of store merchandise within the selling space is a big factor in helping to generate merchandise sales and subsequent profits.

Staple merchandise is generally placed in a permanent location and does not need to be placed in the heaviest customer traffic areas. Customers will seek out staple items, so placing them in a permanent location makes it easier for customers to locate them when making return visits to the store.

Store Entrance

Space near the store entrance has the greatest customer exposure and the best chance of producing the largest amount of sales. Placing the most appealing merchandise near the front entrance of the store to get customers to come in is a basic merchandising principle.

Impulse Purchases

Impulse purchases are usually small items of merchandise that are purchased with little or no thought on the part of the customer. They are generally placed near the customer entrance, at the checkout area, and in areas of heaviest customer traffic so that customers can easily see them. Candy bars and breath mints are examples of impulse merchandise. They are often placed near the cash registers so customers will easily see and buy them. This placement of impulse items is very common in drugstores, convenience stores, and airport shops.

Point of purchase (POP) displays are sales promotional tools that are designed to encourage impulse purchasing and highlight special offers. Merchandise manufacturers usually supply these displays to retailers to promote the sale of their merchandise. Point of purchase displays are often used at the checkout area so that customers can easily add the item to their purchase.

Related Merchandise

Related merchandise consists of items that are related to each other and that usually sell together. If a customer buys one they will be likely to buy the other. These items should be located near each other; adjacent placement reminds customers of a possible need and makes it convenient.
for them to just pick up the other item and buy it. Razors and shaving cream
are examples of related merchandise.

Summary
In this unit we learned about merchandising and the types of
merchandise stores stock. Next we learned about stock lists and how they
can assist retailers in maintaining and monitoring stock inventory levels. We
then discussed how merchandising affects store sales. Lastly, we reviewed
some mathematics associated with merchandising.

Key Math Concepts

**COMPUTE PLANNED SALES INCREASE**
Merchandising is a tool to help retailers reach their sales goals. Most retailers plan sales goals as a
percentage increase of the previous year’s sales for the same time period. To compute planned sales
increase, use this formula:

\[
\text{Planned Sales Increase} = \text{Last Year's Sales} \times \text{Percentage of Increase Planned}
\]

**TOTAL PRICE PER ITEM**
When placing reorders from the basic stock list, the total price per item is computed using this formula:

\[
\text{Total Price Per Item} = \text{Quantity Ordered} \times \text{Price Per Unit}
\]

Key Terms

**Merchandising**
The coordination of buying merchandise that
customers want in the proper quantities and then
selling that merchandise at a price that customers
are willing to pay.

**Staple Merchandise**
The basic stock of a store that is stocked year round
and comprises a good portion of store sales.

**Fashion Merchandise**
Items that are stocked for several years and that
have solid sales over that time period.

**Seasonal Merchandise**
Items that sell well during particular times of the
year that are stocked only for that selling period.

**Convenience Merchandise**
Items customers buy without thinking very much
about the purchase.

**Stock Lists**
Merchandise planning tools consisting of itemized
and detailed listings of the merchandise a store or
department should have for sale.

**Basic Stock List**
A list of the staple merchandise that the store
should always keep in inventory.

**Model Stock List**
A list used to track of items of fashion merchandise.

**Never-out Stock List**
A list used to keep track of the best-selling
merchandise.

**Impulse Purchases**
Usually small items of merchandise that are
purchased with little or no thought on the part of the
customer.

**Point of Purchase (POP) Displays**
Sales promotional tools that are designed to
courage impulse purchasing and highlight special
offers.

**Related Merchandise**
Items that are related to each other and that usually
sell together.
1. Review of the basic stock list for your gift shop indicates that you need to reorder the following items: 12 glass vases @ $8.75 each, 6 silver plated vases @ $12.50 each, 12 glass paperweights @ $9.25 each, 6 glass candy dishes @ $14.25 each, and 18 glass candlesticks @ $7.75 each. What is the total cost for each type of item? What is the total cost for all the items? The vendor offers a 2% discount for payment within 30 days. Assume that you will take advantage of this discount. Shipping is $14.95. What is the total amount of this reorder?

2. You are updating the sales plan for your store for the upcoming holiday season. You usually plan for a 10% increase in sales over the same time period last year. However, this year your area is experiencing an economic downturn. You have determined that a realistic figure to plan for is a 6% sales increase. Using the numbers below, compute the projected 6% sales increase for the first week of the season and total the weekly sales, round to the nearest dollar.

<table>
<thead>
<tr>
<th>Day</th>
<th>Last Year's Sales</th>
<th>Projected Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday</td>
<td>$3,145</td>
<td></td>
</tr>
<tr>
<td>Tuesday</td>
<td>$2,867</td>
<td></td>
</tr>
<tr>
<td>Wednesday</td>
<td>$3,028</td>
<td></td>
</tr>
<tr>
<td>Thursday</td>
<td>$3,371</td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td>$4,645</td>
<td></td>
</tr>
<tr>
<td>Saturday</td>
<td>$5,739</td>
<td></td>
</tr>
<tr>
<td>Sunday</td>
<td>$5,674</td>
<td></td>
</tr>
<tr>
<td>Weekly Sales</td>
<td>$28,469</td>
<td></td>
</tr>
</tbody>
</table>

3. After reviewing your model stock list you discover a changing sales pattern over the last three months on the most popular style of running shoe. The data note the following sales per month: May–120 units, June–165 units, July–180 units. Your normal stock level for this shoe is 200 units. You have missed a few sales recently due to out-of-stock issues in popular sizes. The vendor for this national brand has just informed you that they are planning a major advertising campaign for this style of running shoe over the next two months. Calculate the average monthly increase in sales over the last two months and, based on these data, determine what your inventory for this shoe should be over the next two months. You will need to explain your rationale to support your projection.

4. You are planning the fall sweater merchandise levels for your clothing store. Last year your sweater sales were down 25% from the previous season. The store had projected sales of 500 sweaters. Calculate the number of units the 25% sales decline represents; then compute the total projected sweater sales with a 17% planned increase over last year.
1. You are the manager of a greeting card and gift shop. You are preparing a basic stock list for the store. List five items that should be included on the list and explain your rationale for each item.

2. A local sporting goods store is located in a metropolitan area where the NFL franchise won the Super Bowl this year. It is now late spring following the win and store management needs to forecast the stock plan for fall sales of the local football merchandise branded with the winning team's logo. Advise them on how they might approach the plan and explain the rationale for your recommendations.

3. There are four merchandise types as noted in this unit. List the four types and give examples that would be relevant for a local organic food store.

4. You have just been appointed manager of a local health club. The owner has asked you to map out a strategy to sell more convenience items that would be purchased on impulse as customers check in and out of the club. Outline a strategy and explain your rationale.
GOAL: Your goal is to use merchandising to raise your store’s revenue to $75,000 in weekly revenue for at least one week.

YOUR SITUATION: In this lesson you do not need to worry about carrying slushies, coffee or magazines. You currently have shelf space allocated for all the other products. You control only Merchandising. All other actions are controlled for you.

1. Run the Merchandising, Run To, Financials, and Products sections of the Tutorial.

2. Open the Merchandising lesson.

3. Using Options -> Run To, run the simulation to January 22nd. Click Financials and record the revenue for the most recent week on Worksheet 1 in row 1.

4. Now you will make some basic merchandising changes and note the results. First, swap the shelf positions of Bread (considered a staple or need item) and Wiper Fluid (considered an impulse item). Using Options -> Run To, run the simulation to February 12th.

QUESTION 1: Use the Products report to answer the following questions. Did sales of Bread go up after the switch? Did sales of Wiper Fluid go down? Were combined sales of the two products, higher or lower after the swap? Explain why this might be.

6. Swap the positions of Detergent and Salsa. This places Salsa right above Nacho Chips. Using Options -> Run To, run the simulation to February 26th.

QUESTION 2: Using the Products report, did Salsa sales go up or down after the swap? Explain why this might be?

7. Now use merchandising to increase weekly sales to $75,000 just by rearranging products on the shelves. Click on the fixtures, rearrange any or all of the products in your store. You cannot change fixture types (refrigerator or regular rack); you can only rearrange products on fixtures. Pay attention to where you place likely “needs” and “impulse items.” Pay attention to products that could sell better if placed together.
8. Run the simulation for 3 simulated weeks. Click Financials and record your revenue for the last week on line 2 of Worksheet 1.

9. Repeat Step 7 and 8 several times. Each time, enter your weekly revenue on a new line of Worksheet 1. Use Print on the File menu to print out your best performing store layout. Hand in the worksheet and the print-out of your best performing store layout.

**WORKSHEET 1**

<table>
<thead>
<tr>
<th>Store Layout</th>
<th>Revenue (After 3 wks.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>

**QUESTION 3:** Which products do you think are primarily impulse items?

**QUESTION 4:** Which products do you think are primarily staple or need items?

**QUESTION 5:** Which type of product would you generally place in the back of the store, needs or impulse items?

**QUESTION 6:** Which type of product would you generally place by the cash register, needs or impulse items?

**QUESTION 7:** Which products were complementary and benefited from being placed next to related products?